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ĐỀ CƯƠNG ÔN TẬP TIN HỌC 9 – HKII

Năm học: 2010 – 2011
A. NỘI DUNG BÀI HỌC

BÀI THỰC HÀNH 6: BÀI TRÌNH CHIẾU ĐẦU TIÊN CỦA EM

· Khởi động PowerPoint, chọn lệnh Start ( All Programs ( Microsoft PowerPoint
· Để chèn thêm trang chiếu mới, ta chọn lệnh: Insert ( New Slide.

· Để hiển thị và áp dụng các mẫu bố trí nội dung cho trang chiếu, chọn lệnh: Format ( Slide Layout.
· Để chọn đồng thời nhiều trang chiếu không liền nhau: Nhấn giữ phím Ctrl và chọn từng biểu tượng của chúng.

· Để chuyển đổi chế độ sắp xếp các trang chiếu ta chọn lệnh Silde Sorter View ở góc dưới.

· Các tệp trình chiếu do PowerPoint tạo ra có phần mở rộng là PPT.
· Để thoát khỏi PowerPoint, chọn lệnh File --> Exit hoặc nháy vào nút Close.
· Để trình chiếu bắt đầu từ trang đầu tiên, chọn lệnh Slide Show ( View Show hoặc nhấn phím F5.

· Để trình chiếu bắt đầu từ trang hiện hành ta nhấn tổ hợp phím Shift + F5.

BÀI 10: MÀU SẮC TRÊN TRANG CHIẾU

1. Màu nền trang chiếu

· Màu sắc làm cho trang chiếu thêm sinh động và hấp dẫn. Màu sắc trên trang chủ yếu là màu nền trang chiếu và màu chữ.

· Các bước tạo màu nền cho 1 trang chiếu:

· Chọn trang chiếu trong ngăn trái (ngăn Slide).

· Chọn lệnh Format ( Background.
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 và chọn màu thích hợp.

· Nháy nút Apply trên hộp thoại.

· Lưu ý: Nháy nút Apply to All trong bước 4 ở trên, màu sắc sẽ áp dụng cho toàn bộ bài chiếu.

2. Định dạng nội dung văn bản

· Chọn phông chữ, kiễu chữ, cỡ chữ và màu chữ.

· Căn lề (trái, phải, giữa trong khung văn bản)

· Tạo các danh sách liệt kê

3. Sử dụng mẫu bài trình chiếu

· Để các mẫu bài trình chiếu xuất hiện ở ngăn bên phải cửa sổ nháy nút [image: image2.png]- Design



 trên thanh công cụ

· Để áp dụng mẫu trình chiếu có sẵn cho một hay nhiều trang chiếu, chọn trang chiếu đó và thực hiện các bước sau đây:

· Nháy nút mũi tên [image: image3.png]


 bên phải mẫu

· Nháy Apply to Selected Slide để áp dụng mẫu cho các trang chiếu đã chọn hoặc Apply to All Slide để áp dụng cho mọi trang chiếu

4. Các bước tạo bài trình chiếu

· Chuẩn bị nội dung cho bài trình chiếu (quan trọng nhất)

· Chọn màu hoặc hình ảnh nền cho trang chiếu.

· Nhập và định dạng nội dung văn bản

· Thêm các hình ảnh minh họa

· Tạo các hiệu ứng động

· Trình chiếu kiểm tra, chỉnh sửa và lưu bài trình chiếu

BÀI THỰC HÀNH 7: THÊM MÀU SẮC CHO BÀI TRÌNH CHIẾU

· Tạo bài trình chiếu mới bằng lệnh File ( New và nháy Blank Presentation trong ngăn bên phải.

BÀI 11: THÊM HÌNH ẢNH VÀO TRANG CHIẾU

1. Hình ảnh và các đối tượng khác trên trang chiếu

· Để chèn hình ảnh vào trang chiếu ta thực hiện các thao tác sau đây:

· Chọn trang chiếu cần chèn hình ảnh vào.

· Chọn lệnh Insert ( Picture ( From File. Hộp thoại Insert Picture xuất hiện.

· Chọn thư mục lưu tệp hình ảnh trong ô Look in.

· Nháy chọn tệp đồ họa cần thiết và nháy Insert.
· Có thể chèn hình ảnh, âm thanh hoặc đoạn phim vào các trang chiếu để minh họa hoặc giải thích nội dung.

2. Thay đổi vị trí và kích thước hình ảnh

· Để thay đổi thứ tự xuất hiện của các hình ảnh ta thực hiện các bước sau:

· Chọn hình ảnh cần chuyển lên lớp trên (hoặc đưa xuống lớp dưới)

· Nháy nút phải chuột lên hình ảnh để mở bảng chọn tắt.

· Nháy vào Order rồi chọn Bring to Front để chuyển hình ảnh lên trên hoặc Send to Back để đưa xuống dưới.

· Có thể thực hiện các thao tác trên đối với các đối tượng khác như khung văn bản, đoạn phim…

3. Sao chép và di chuyển trang chiếu

BÀI 12: TẠO CÁC HIỆU ỨNG ĐỘNG

1. Chuyển trang chiếu

· Các bước đặt hiệu ứng chuyển cho các trang chiếu như sau:

· Chọn các trang chiếu cần tạo hiệu ứng

· Mở bảng chọn Silde Show và chọn lệnh Silde Transition…
· Nháy chọn hiệu ứng thích hợp trong ngăn xuất hiện sau đó ở bên phải cửa sổ

· No Transition (không hiệu ứng) là ngầm định.

· Có 2 tùy chọn điều khiển việc chuyển trang:

· On mouse click: chuyển trang khi nháy chuột.

· Automatically after: Tự động chuyển trang trong khoảng thời gian (tính bằng giây)

· Nháy Apply to All Slide để áp dụng một hiệu ứng chuyển cho tất cả các trang chiếu của bài trình chiếu.

2. Tạo hiệu ứng động cho đối tượng

· Để chọn hiệu ứng động có sẵn cho các đối tượng ta thực hiện các thao tác sau:

· Chọn các trang chiếu cần áp dụng hiệu ứng động có sẵn

· Mở bảng chọn Slide Show và chọn Animation Schemes…

· Nháy chọn hiệu ứng thích hợp trong ngăn bên phải cửa sổ

· Để chọn hiệu ứng động cho từng đối tượng ta thực hiện như sau:

· Chọn đối tượng cần tạo hiệu ứng

· Mở bảng chọn Slide Show và chọn Custom Animation…
· Click chuột vào Add Effect trong ngăn bên phải cửa sổ.

3. Sử dụng các hiệu ứng động

· Nên sử dụng các hiệu ứng động ở mức độ vừa phải, phục vụ cho mục điích chính là truyền đạt nội dung.

4. Một vài lưu ý khi tạo bài trình chiếu

· Khi tạo nội dung cho các trang chiếu cần tránh:

· Các lỗi chính tả;

· Sử dụng cỡ chữ quá nhỏ;

· Quá nhiều nội dung văn trên một trang chiếu

· Màu nền và màu chữ khó phân biệt

I. PHẦN TRẮC NGHIỆM

Hãy khoanh tròn vào những câu đúng nhất: mỗi câu đúng 

1. Các bước khởi động phần mềm trình chiếu Microsoft PowerPoint là:

a. Start ( Program ( Microsoft Office ( Microsoft PowerPoint

b. Program ( Start ( Microsoft Office ( PowerPoint

c. Start ( Microsoft Office ( PowerPoint ( Program 


d. Start ( Program ( PowerPoint

2. Tên phần mềm nào sau đây là phần mềm trình chiếu ?

a. Kompozer




b. Microsoft Word

c. Microsoft PowerPoint



d. Auducity.

3. Nội dung cơ bản trên các trang chiếu có các dạng nào ?

a. Văn bản





b. Hình ảnh

c. Âm thanh




d. Cả 3 câu đều đúng

4. Trong một bài trình chiếu có thể có bao nhiêu trang chiếu?

a. 5






b. 10

c. 20





d. Không giới hạn

5. Để thêm một trang chiếu mới ta chọn lệnh:

a. File ( Exit




b. Insert ( New Slide

c. Slide ( View




d. Format ( Slide Layout

6. Cách tạo màu nền cho một trang chiếu ?

a. Chọn trang chiếu ( chọn Format ( Background ( nháy nút [image: image4.png]


 và chọn màu ( nháy nút Apply to All trên hộp thoại

b. Chọn trang chiếu ( chọn Format ( Background ( nháy nút [image: image5.png]


 và chọn màu ( nháy nút Apply trên hộp thoại

c. Chọn trang chiếu ( Format ( Background ( nháy nút Apply trên hộp thoại.

d. Chọn trang chiếu ( Format ( Background ( nháy nút Apply  to All trên hộp thoại.

7. Em có thể chèn hình ảnh vào trang chiếu bằng cách nào ?

a. Insert ( text box




b. Format ( Font

c. Insert ( Picture ( From File…


d. Edit ( Select All

8. Cách mở mẫu bài trình chiếu ( Slide DeSign…) ? 

a. Insert ( Slide DeSign…



b. Format ( Slide DeSign…

c. View ( Slide DeSign…



d. Tools ( Slide DeSign…

9. Để trình chiếu từ trang đầu ta ấn phím sau đây trên bàn phím:

a. Enter

b. F5

c. Insert

d. Ctrl+F4.




10. Các bước tạo hiệu ứng động tùy biến cho đối tượng.

  a. Mở bảng chọn Slide Show ( Animation Schemes…Nháy chọn hiệu ứng thích hợp.

  b. Chọn các trang chiếu.  Mở bảng chọn Slide Show ( Animation Schemes…Nháy chọn hiệu ứng thích hợp.

  c. Chọn các trang chiếu.  Mở bảng chọn Slide Show ( Slide Transition…Nháy chọn hiệu ứng thích hợp.

  d. Chọn các trang chiếu.  Mở bảng chọn Slide Show ( View…Nháy chọn hiệu ứng thích hợp.

11. Hiệu ứng động là công cụ hỗ trợ trình bày nội dung trên trang chiếu. Có mấy loại hiệu ứng động?

   a. 1

     b. 2



c. 3



d. 4
12. Để sắp xếp các trang chiểu ta chọn lệnh:

   a. Normal View

b. Slide Sorter View  
c. Slide Show 
d. Notes Page

13. Các bước  sao chép nhiều trang chiếu ?

B1: Chọn trang chiếu đầu tiên, giữ phím CTRL và chọn các trang chiếu tiếp theo

B2: Nháy vào nút Copy rồi nháy chuột vào nơi cần sao chép

B3: Nháy vào nút Paste

14. Cách  mở mẫu bố trí ( Slide Layout ) ?

a. Insert ( Slide layout…

b. Format ( New Slide

c. Format ( Slide Layout...

d. Tools  ( Slide Layout...

15. Để tạo hiệu ứng động có sẵn cho các đối tượng trên trang chiếu ta thực hiện theo trình tự nào?

a. Mở bảng chọn Slide Show ( Slide Transition.

b. Mở bảng chọn Slide Show ( View Show.

c. Mở bảng chọn Format ( Slide Layout.

d. Mở bảng chọn Slide Show(Animation Schemes

16. Các hiệu ứng động làm cho việc trình chiếu trở nên:


a. Không thuận tiện.


           b. Hấp dẫn, sinh động và thu hút sự chú ý.


c. Không cần thiết.



d. Các câu trên đều sai 

17. Để tạo hiệu ứng động đơn giản cho đối tượng, ta chọn:


a. Slide Show → Animation Schemes.

b. View → Slide Layout.


c. Insert → Picture → From File.

           d. Format → Background.

18. Nên sử dụng các hiệu ứng động ở mức độ :


a. Càng nhiều càng tốt.


b. Mỗi nội dung nên tạo nhiều hiệu ứng.


c. Mức độ vừa phải.


d. Không nên tạo hiệu ứng động.

19.  Khi trình chiếu nội dung của mỗi trang chiếu: 


a. Bắt buộc phải có 1 hiệu ứng âm thanh đi kèm.


b. Bắt buộc phải có 2 hiệu ứng âm thanh trở lên.


c. Tùy theo nội dung thể hiện để chọn âm thanh cho phù hợp.


d. Tuyệt đối không nên sử dụng hiệu ứng âm thanh.

21. Yếu tố nào ảnh hưởng đến tính hấp dẫn, sinh động cho bài trình chiếu?

    a. Màu sắc (màu nền, màu chữ, màu của hình ảnh)
 b. Định dạng văn bản

    c. Hiệu ứng động





 d. Cả 3 yếu tố trên  

22. Để chuyển một hình ảnh được chọn lên lớp trên ta thực hiện theo trình tự nào?

a. Nháy chuột phải lên hình ảnh ( Order ( Bring Forward.

b. Nháy chuột phải lên hình ảnh ( Order ( Send to Back.

c. Nháy chuột phải lên hình ảnh ( Order ( Bring to Front.

d. Nháy chuột phải lên hình ảnh ( Order ( Send Backward.

23.  Có thể sử dụng bài trình chiếu để: 

a. Giảng dạy

b. Giải trí

c. Quản cáo

d.   Cả 3 câu a, b và c đều đúng

24. Tác dụng của khung văn bản có sẵn trên trang chiếu là:


a. Để nhập văn bản
b. Nhập hình ảnh _ âm thanh


   c. Câu a và b đều sai  
d. Câu a và b đều đúng


25. Nội dung trên trang chiếu là:


a. Văn bản


b. Hình ảnh _ biểu đồ


c. Âm thanh


d. Tất cả các câu a, b, c đều đúng

26. Thành phần cơ bản của một bài trình chiếu là:

 
a. Văn bản


b. Hình ảnh _ biểu đồ


c. Tập hợp các trang chiếu


d. Âm thanh

27.  Với phần mềm trình chiếu Power point. Để tạo màu nền cho trang chiếu, chọn lệnh


 a. Format ( Background
b. Format  ( More color


c. Edit ( Background
d. View ( Background

28. Trong khi làm việc với màn hình trình chiếu Power point. Để thêm trang chiếu mới chọn lệnh: 


a. Insert ( New slide
b.File ( New slide



c. Edit ( New slide 
d. Format ( New slide

29.  Trong khi làm việc với phần mềm trình chiếu Powerpoint. Để tạo bài trình chiếu mới:

a. File ( New
b. Edit ( New

c. Format ( New
d. Insert ( New

30.  Chức năng chính của phần mềm trình chiếu là:

a. Tạo các bài trình chiếu

b. Trình chiếu các trang của bài trình chiếu

c. Soạn thảo văn bản

d. Câu a và b đúng
32. Muốn tạo hiệu ứng chuyển cho các trang chiếu ta cần thực hiện các lệnh sau:

    a. Slide show ( Slide transition    b. Slide show ( Animation Schem
    c. Slide Show ( View Show         c. Insert → Picture → From File 
33.  Nếu muốn áp dụng 1 hiệu ứng chuyển trang cho tất cả các trang chiếu . Ta nháy nút:

a. Apply to All Slides




b. Apply to All


c. Apply to Master





d. Cả a và b đúng

34 Cách chèn thêm trang chiếu (slide) mới?

a. Nháy vào nút New Slide…



b. Insert ( New Slide



c. Nháy phải ở khung bên trái và chọn New Slide
d. Cả 3 đều được.

35. Em có thể chèn hình ảnh vào trang chiếu bằng cách nào?

a. Insert ( Text box




b. Format (Font

c.Insert ( Picture( from file…


d. Edit ( Select All.

36. Cách tạo màu nền cho 1 trang chiếu?

a. Chọn trang chiếu(Chọn Format / Background(Nháy nút  
[image: image6]  và chọn màu ( Nháy nút Apply to All trên hộp thoại.

b. Chọn trang chiếu(Chọn Format / Background(Nháy nút  
[image: image7]  và chọn màu ( Nháy nút Apply trên hộp thoại.

c. Chọn trang chiếu( Chọn Format / Background( Nháy nút Apply trên hộp thoại.

d. Chọn trang chiếu(Chọn Format / Background( Nháy nút Apply to All trên hộp thoại.

37.  Khi tạo các hiệu ứng chuyển trang chiếu, cùng với kiểu hiệu ứng ta còn có thể tuỳ chọn các mục nào sau đây?

a. Thời điểm xuất hiện.




b. Hình ảnh xuất hiện.

c. Âm  thanh đi kèm.




D. Cả a và c đúng.

38. Cách mở mẫu bố trí (slide layout)?

a. Insert ( Slide layout…

b. Format ( New Slide…
 

c. Format ( Slide layout…

d. Tools ( Slide layout…


II. PHẦN TỰ LUẬN

1. Hãy nêu các bước để tạo một bài trình chiếu?

     2. Hãy trình bày những điểm cần tránh khi tạo bài trình chiếu?

     3. Hãy nêu các bước cơ bản để tạo màu nền cho trang chiếu?


4. Hãy nêu các bước cơ bản để chèn hình ảnh vào trang chiếu?  

5. Khi chèn hai hình ảnh trên một trang chiếu, em thấy một hình ảnh che lấp một phần của hình ảnh kia. Tại sao? Nếu muốn hiển thị đầy đủ cả hai hình ảnh trên cùng trang chiếu, em cần thực hiện các thao tác gì?

6. Hãy nêu các bước để thay đổi thứ tự của hình ảnh?

7. Hãy nêu các bước để thay đổi vị trí và kích thước của ảnh đã chèn vào trang chiếu?

8. Hãy nêu các bước để chọn, sao chép và di chuyển toàn bộ trang chiếu?

9. Hãy cho biết mục đích của việc chèn hình ảnh, âm thanh hoặc đoạn phim vào các trang chiếu?

10. Với phần mềm trình chiếu chúng ta có thể thiết lập những tùy chọn nào cho trang chiếu?

                                                     Trang 1
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